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ABSTRACT

This report consists of a research project on the prediction of particle collection

efficiency, the porosity and the pressure drop across filtration media at stationary

phase. Two types ofmodel were compared in this project. The first one is the model

developed by Awni Y. Al-Otoom, which simulates particle distribution on the filter

cloth and predicts whether each particle was trapped on or escapes the filter cloth.

The filtration parameters will becalculated by the number ofparticles trapped and the

geometry of the cake simulated on the filter cloth. The second model is developed
based on flow through porous media using Darcy's Law and FEMLAB software. In

this model, the pressure drop will be simulated using the software and other

parameters will be calculated from it. From the project, it can be concluded that the

pressure drop shown by both models agree with thetheory. This result was the same

for porosity and efficiency predicted by Al-Otoom. However, the FEMLAB model

needs more experimental information as the porosity prediction is only applicable to

the filter cloth porosity, while efficiency prediction requires the pressure drop

contributed solely by the filter cake.
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CHAPTER 1

INTRODUCTION

1.1 Background of Study

Pich (1987) defined filtration as "the process of separating dispersed particles from a

dispersing fluid by means of porous media The dispersing medium can be a gas or

liquid." The filtration process which uses gas as the medium is known as aerosol

filtration.

In filtration processes, the trapped particles build up on the filter media and form

cakes. Having a porous structure, the cakes may also act as a filter for incoming

particles. Addition of the cakes on the filter media alters the filtering performance,

resulting in change of the collection efficiency and pressure drop. As the cakes

become thicker, these properties change accordingly.

However, Al-Otoom (2005) points out that "the diversity andcomplexity of filtration

media makes the evaluation of the performance of such media extremely difficult to

perform experimentally" (p.52) and ''theoretical approaches are generally considered

the key to predicting the cake filtration performance" (p.52). A new approach to

predict filtration performance was introduced by Al-Otoom, which is a model that

predicts the collection efficiency, cake thickness and porosity and the pressure drop

across it with respect to filtration time. The cake thickness was predicted by

determining whether randomly distributed particles pass through the filter media or

trapped and contribute to the formation of the cake. This prediction was done using

the geometry of theparticles andfilter pores.



As an air filtration model canact as a guidein research donein UTP, it may be useful

to verify the model by Al-Otoom by developing another model using resources

available in the university. TheFEMLAB software is suggested as a good platform to

develop the model.

1.2 Problem Statement

Filtration is a well-known solution for particulate emission treatment. Having a model

for research on this subjectmay help in predicting the properties associated with this

process. Several models have been designed for this purpose. Thus, for model

verification purpose, a studyon comparison between models is required.

1.3 Objective of Study

The followingare the objectives of the study:-

i. To predict the collection efficiency, the porosity, and the pressure drop across

filter cakes in particulate air filtration at stationary phaseusingFEMLAB

ii. To comparethe model with the model developed by Al-OtoomAY

1.4 Scope of Study

The scope of this study is the prediction of the collection efficiency, cake porosity

and the pressure drop across filter cakefor particulate air filtration at stationary phase

using the FEMLAB software. It also includes the comparison between the FEMLAB

model and model by Al-Otoom A.Y.

1.5 Relevancy of the Project

Using experimental method to determinethe filter parameters is a difficulttask With

models developed in this project, theseparameters can be predicted and the value can

be obtained without having to do experimental work. This may save time and

resources and may be very beneficial in research and design purposes. Models may

also serve as an education aid. This project may also promote FEMLAB usage among

UTP students, as for nowthe software is found underutilized dueto lack of modelling

projects and assignments. Also, this project may contribute to the development of



models by verifying whether the approach by Al-Otoom agrees with the FEMLAB

model.

1.6 Feasibility of the Project within the Scope and Time Frame

This project is feasible within the scope because both of them were based on the air

filtration system. In terms oftime frame, this project was feasible because it involves

mainly computer based activities that are compatible with the daily schedule. Also, all

the resources needed for this project is available in the university so that there is no

need for time consuming travel to other location to get its resources or to use

equipments.



CHAPTER 2

LITERATURE REVIEW / THEORY

2.1 Filtration Parameters

The filtration process can be characterized by several parameters. All the parameters

will be described according to Pich (1987). First, the pressure drop across the filter,

Ap is defined by

Ap = pi - p2 (1)

where pi is the gas pressure before the filter and p2 after the filter. This quantity is

dependent on the property of the fluid and filter media in the case of a clean filter.

However, as the filtration process proceeds, the pressure drop will become dependent

on the properties of particles that deposits on and inside the filter.

The filter efficiency is defined by

n-Gi-G? (2)

Gi

where Gi is the flux of particles into the filter and G2 is the flux of particles coming

out of the filter. Other than flux, Gi and G2 can be expressed in terms of number,

weight, activity etc. The penetration of the filter P is defined by

P = l-Tt (3)

which represents the fraction of particles that escapes the filter. Other parameters

include the filter capacity and filter quahty (p 1-2). However, they will not be

discussed further as they are not directly related to this study.

A



Pich (1987) also states that the three elements lhat participate in the filtration process,

namely the dispersed particles, the dispersing medium and the porous substance can

be characterized by a number of factors (p. 2). Table 1 lists the respective factors

corresponding to each filtration element.

Table 1 Characterizing Factors on Filtration Process

Filtration element Characterizing factors

Dispersed particles Diameter, size distribution, shape, mass, density, electric

charge, electric constant, chemical composition and

concentration (number, weight volume, active concentration)

Dispersing medium Velocity, density, absolute temperature, pressure, dynamic

viscosity, kinematic viscosity and humidity

Porous substance Surface area, thickness, size of structural units and their

arrangement and distribution in the filter, porosity, specific

surface, electric charge, dielectric constant and chemical

composition

The pressure drop Ap and filter efficiency i\ depend on nearly all factors mentioned

above. The determination of their dependence on these factors is the basic problem of

filtration (Pich, 1987, p. 3)

Porosity is defined by Schlumberger (2005) as the percentage of pore volume or void

space, or that volume within porous medium that can contain fluids. Porosity can be

divided into two types. Total porosity means the total pore volume per unit volume of

porous medium and is measured in volume/volume, percent or porosity units

(Schlumberger, 2005). On the other hand, effective porosity means the interconnected

pore volume or void space in a porous medium that contributes to fluid flow or

permeability in a system (Schlumberger, 2005). However, in this study, all void space

in the porous media is assumed to be interconnected. This means that the effective

porosity is equal to total porosity.

According to Pich (1987), there are two different phases of filtration. The first one

involves the deposition of particles on a clean filter with a definite structure. The



amount of deposited particle is small and the structural change was assumed to have

only a little influence on both pressure drop and efficiency. This phase, where Ap and

n are independent of time, is known as stationary filtration. Practically, filtration

process can be treated as a stationary phase in the initial stage of the filtration process

or for low concentrations of the inlet aerosol. The second phase is more complex. At

this point, structural changes due to die particle deposition may change Ap and n with

time. These two parameters may increase or decrease. Besides, the filter media may

become clogged. This phase is known as nonstationary filtration (p.3).

2.2 Governing Equations for Fluid Flow in Porous Flow Region

Bird, Stewart and Lightfoot (2002) states that the flow characteristic in the filter

media can be described using Darcy's equation,

Ap = 1 \iuL (4)

k

where k = permeability of the porous medium

u - superficial velocity

p = fluid dynamic viscosity

L = porous media thickness

Superficial velocity u is defined as the volumetric flow rate through a unit cross-

sectional area of the filter medium, averaged over a small region of space - small

with respect to the macroscopic dimension of the flow system, but large with respect

to the pore size (p. 149). Superficial velocity is also known as face velocity and can

be calculated using the following equation

u-Q/A (5)

where Q = volumetric flow rate

A= cross sectional area offilter

According to Schlumberger (2005), the permeability of the porous media is the

measurement of a medium's ability to transmit fluids. This parameter may be applied

to the filter cloth of filter cakes. Permeability can be divided into three types,

absolute, effective and relative permeability. Absolute permeabiUty is the

measurement of the ability to flow or transmit fluids through a medium, conducted



when a single fluid, or phase, is present in the medium (Schlumberger, 2005).

Effective permeabiUty is the ability to preferentially flow or transmit a particular fluid

when other immiscible fluids are present in the system, while relative permeability is

the ratio of effective permeability of a particular fluid at a particular saturation to

absolute permeability of that fluid at total saturation (Schlumberger, 2005). Any

'permeabiUty' terms found in this report will be referring to absolute permeability.

According to de Nevers (2000), the resistance of the filter cloth can be assumed as a

constant with time. For a filter cake, a uniform cake will have a resistance that is

proportional to its thickness (p.283).

The Darcy equation is used for low speed, incompressible, Newtonian flow, as how

filtration process usually is (Pich, 1987, p. 13). According to Nassehi et al (2004), the

Darcy equation is suitable for low-permeability system This equation also "does not

account for viscous effects" ("FEMLAB 3 User's Guide", 2004, p.545). Thus, it is

suitable for low viscosity system.

2.3 Filtration Model by Novick and Klassen

Novick and Klassen (1998) has studied various models that predicted mass loading as

a function of the increase of Ap across the filter. One of the approaches studied

models physically the relationship between Ap and mass loading, and then

determining factors that are necessary to make the model fit the data AU the

description of this model in this chapter, unless indicated, is according to Novick and

Klassen (1998, p.338-343).

The model describes the total pressure drop across the filter as the summation of the

pressure drop across a clean filter Ap0 and the pressure drop across the filter cake

Apcake, which is due to particle loading.

Ap = Ap0 + Apcake (6)

Assumptions for this model are that both filter and filter cakes are rigid, porous bed

superimposed on each other and that the flow through them is laminar. Each

component of the pressure drop is then described using Darcy's Law.

Ap = KiW + K2wM/A (7)



where Apo = Ki«, Apcate = K2WM/A and M/A is the mass loading

Ki is a parameter that only depends on the properties of the filter cloth and is

determined from the slope of Ap versus u graph. On the other hand, K2 is modeled by

considering that Ap^ can be determined using Stokes Law

Apcake = 3jipwdpN/C (8)

where N = numbers of spheres (particles) per unit area

C = Cunningham slip correction factor

The cake is assumed to be comprised of isolated spheres of porosity approaching 1.

The Cunningham slip correction factor is defined by Sioutas and Koutrakis (1998) as

C = 1 + _2_ 16.32 + 2.01 exp(-0.1095Pdp)] (9)

pdp

where p is the absolute pressure in mmHg and dp is particle diameter expressed in

microns (p. 456).

The mass of particles collected per unit area W is

W=Np(7c/6)dp3 (10)

2.4 Filter Cake Buildup Model by Al-Otoom

A model developed by Al-Otoom A.Y. uses random distribution to predict the falling

coordinate of each particle. Then, using the location and geometry of the filter media

pores and particles that are already deposited on it, the model determines whether the

falling particle will pass the filter cake or not. If not, it will contribute to the increase

of the cake thickness. The efficiency of the filter is then calculated using the

foUowing equation

n = no. ofparticles trapped on the filter media x 100% (11)

no. ofparticles exposed to the filter media



The porosity of the cake e will be calculated using

8 = 1- Particles volume (12)

Filtration area x Cake thickness

The pressure drop across the filtermedia is determined using eitherErgun's equation

(13) or Rudnick-Happel equation (14)

AD \5QQfiV(l-;i)
AP = =*t- -—z-Z-L

ApJ
p P

£•

AP
V

Apvd~p
x

3-r-2(l-#

3-45(1- #-?-45(i-£)f--2(i-a)2B

where pp = particle density

dp = particle mean diameter

e - porosity

(13)

t.

(14)

Another variation of Ergun equation is stated by Tardos (1998) which in

dimensionless form /0 is

/o [s3 / (1- e)] - 180(1- £)/Reo + 1.8 (15)

The actual pressuredrop can then be calculatedby

Ap = fapu2L

2rp

where the Reynolds number is expressed as

Reo - 2r2up

P

where rp = mean particle radius

p = fluid density

L = filter thickness in the direction ofthe flow

(16)

(17)



The model is based on the following assumptions:-

i. Filter media has a uniform surface porosity with an average pore diameter, pa

and a constant distance between all successive pores,

ii. Pores in filter media are cylindrical,

iii. Particles that enter pores escape from the filter cake,

iv. Particles that come into contact with other particles adhere to the surface with

these particles

v. Particles have uniform spherical shapes,

vi. Particles are incompressible,

vii. Particle size distributions and the particle falling location are randomly

distributed.

The flow diagram for the model by Al-Otoom is shown in Figure 1. The filter

porosity, dimension and mean pore diameter are used to assign pore locations on the

filter cloth. The mass mean particle diameter will be used to generate varieties of

particle diameters within a specified range. The explanation for each model stage will

be included in the later sections.

10



Start

Read Maximum Particle Diameter

Read Filter Porosity

Read Filter Surface Mean Pore Diameter

Read Filter Dimension

I
Assign filter pore location

I
Generate particle sizes with random distribution

Assign a location for every particles

J.
Compare particle location with pore locations

Calculate distance between particles and pore

locations

I
Calculate the distance between this particle and the rest

Determine the minimum distance

Calculate the new thickness

Calculate percentage passes the filter cake

Calculate the porosity

Figure 1 Flow Diagram for Model Calculation by Al-Otoom

Source: Al-Otoom (2005)
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2.4.1 Pore location assigning

The location of each pore is represented by its center coordinate. To determine the

coordinate of each pore center, the distance between two successive pores S is

calculated. The number ofpores in the x-direction is

x = L (18)

S

where L is the length of the filter cloth. The number ofpores in the y-direction is

y = W (19)

s

where W is the width of the filter cloth. Thus, the total number ofpores is

xy = lM (20)

S2

The total number of pores can also be calculated alternatively using

Total pore volume = LWHs = LWe (21)

Volume ofone pore (n/4)dp2U (ji/4)dp2

where H is the thickness of the filter cloth. Equating equation (20) and (21) will result

in the equation to find S

Ss /"/^
8 (22)

The pore x and y coordinates were then determined by the following equations

P|x(a,b) = P|x(a-l,b) + S (23)

P|y(a,b)-P|y(a,b-1) + S (24)

where a and b are integers generated for every pore location an x and y coordinates.

P|x(a-l,b) is the x-coordinate of the previous pore and P|y(a,b-1) is the y-coordinate

of the previous pore.

1?



2.4.2 Particles Radii

The particles radii rp are generated randomly using the maximum particle diameter

dpmax and the following equation

rP(i) = dpmax x Random number (25)

2

Al-Otoom (2005) stated that the mean particle diameter generated is around the half

the value of the dpmax. A typical particle size distribution is shown is Figure 2. The

mass mean diameter obtained in this sample is around 15 urn, which is a normal

distribution found in practical situations.

0.00002

Particle Diameter, m

Figure2 Sampleof particle size distribution generated for dpmax = 31 ^m

Source: Al-Otoom (2005)

Z 4.3 Particle Falling Locations

The coordinates of the particle falling locations are also randomly generated. In this

case the length or width of the filter cloth is used to get the location as a fraction of

the filter cloth length and width. The equations for the x-coordinate x0(i) and y-

coordinateiyo(i)are

x0(i) = Lx Random number (26)

13



CHAPTER 3

METHODOLOGY / PROJECT WORK

The general procedure for this project is illustrated in Figure 3:

Information gathering and
software training

1 ' "

Set up and solve
FEMLAB model

Prediction offiltration parameter
using model by Al-Otoom

•'

Comparison between
models

Figure 3 General Procedure of the project

3.1 Information Garnering and Software Training

Information regarding the research subject is gathered from various sources,

including books, journals, manuals, online articles etc. Copies of relevant documents

were obtained from the library and the supervisor in charge. The software was

accessed from computer laboratories or personal computer to familiarize with its

features. Guide on software usage was obtained from the FEMLAB help file and from

the internet.

is



To get the suitable equation for the model, all equations for momentum balance and

fluid flow in the FEMLAB was listed. Then, their properties are looked up in books.

This is to get information on the suitability of the equation with the system to be

simulated. The FEMLAB model will require an equation to govern the fluid flow in

the porous region. The porous region is the flow region in the filter media. Then,

trials were doneusingtheseequations to find the solution for the flow system.

To obtain the properties needed for the modelling, a pulse jet bag filter which is

available in the university was selected. From this equipment, the following

properties for the model can be determined: filter dimension, pore size, porosity and

permeability. The vendor for this equipment is contacted to obtain these informatioa

The properties and their values are listed in Table 2.

Properties Value

Filter dimension 1 m x 0.4241 mx 0.002 m

Pore diameter (Average) 15 pm

Porosity 0.6

Filter Permeability 2.9115306 xl0_Lim2

Table 2 Properties of the Filter Cloth

3.2 Set Up and Solve FEMLAB model

Once the FEMLAB features and model equations are identified, the project can

proceed by setting up the model using the software.

The first step in setting up models in FEMLAB is the specification of the constants.

The constants are the values or properties for the model. A menu is opened from the

'Options' > 'Constants' drop-down menu to key in the needed data, as shown in

Table 3. When all the constants are gathered in here, it will be easier to be accessed as

the subsequent steps will require changing of some values, including the volumetric

air flow rate and total filtering area.

16



Table 3 Constants for FEMLAB Model

Properties Variable name Value/ expression Unit

Dynamic viscosity of air Eta 1.8 xlO"5 kg/m.s

Density of air Rho 1.2 kg/m3

Filter cloth permeability Perm 2.9115306 x 10"" m1
m

Air flowrate Q Ranged from 130 to

10

m^/hr

Total filtering area A 0.4214x(l to 4) m*

Superficial velocity vO Q/A m/s

The dynamic viscosity and density of air is obtained form literature, whereas the filter

cloth permeability was calculated from the information obtained from the pulse-jet

bag filter operating manual. A set of result from an experiment of filtration using atta

flour as the dust sample is used to calculate the permeability. The equation used is the

Darcy equation. The data from the early stages offiltration is used because the will be

none or very little cake deposited on the filter cloth surface. This will ensure that the

calculated permeability is the permeability of the filter cloth, not the cumulative

permeability of the cloth and the filter cake.

These data were used to construct a model based on Darcy's equation First, the

geometry of the model was made. This means that the shape of the filter cloth was

drawn. Then, the properties of the model, including the constants used, subdomain

and boundary condition were assigned. The fully specified model was men divided

into meshes before solved using the FEMLAB solver. From the solution, many

properties of the filtration process can be obtained.

3.2.1 Model Specifying Steps

Before the model is constructed, the FEMLAB file must be created. When the

FEMLAB programme was opened, the 'Model Navigator' menu was shown on the

screen. Refer to Figure B-1 in Appendices for a view of the 'Model Navigator'. In

this menu, the space dimension and equations used in the model were specified.

Space dimension determines the number of dimensions that the model has, either 1,2

17



or 3. The coordinate system of the model can also be determined, whether Cartesian

or Cylindrical. For this model, the space dimension is set to '3D' and 'Darcy's Law',

'Steady-state analysis' was selected from 'Chemical Engineering Module', in

'Momentum balance' folder. The 'OK' button was used to confirm these selections.

The first step was to draw the geometry of the model. The geometry of the model

consists of a fraction of the filter cloth, with the dimension of 0.1 m x 0.08482 m x

0.002 m. The geometry of the model (See Figure 4) is drawn smaller than the original

filter cloth dimension to fasten up the simulation process. However, the thickness of

the filter cloth is maintained at the original so that the geometry drawn is

representative for the actual filter cloth To do mis, the 'Block' menu was opened

from 'Draw' > 'Block' drop-down menu. In this menu (Refer Figure B-2 in

Appendices), the length ofthe block was specified as follows: X=0.1, Y=0.08482 and

Z=0.002. Other parameters were left as they were, which were. 'Style' = 'Solid',

'Base' = 'Comer', 'Axis Base Point' = (0,0,0), 'Rotation Angle' = 0, 'Axis Direction

Vector' = 'Cartesian Coordinates' at (0,0,1) and 'Name' - 'BLK1'. 'OK' button was

then clicked and the specified block was shown on the coordinate system.

Then, the program will divide the geometry into subdomains, which are defined by as

"a topological part of the modeling space in a geometry model" ("FEMLAB 3 User's

Guide", 2004, p.545). In the case of this model, only one subdomain is present. Darcy

equation was assigned to the existing subdomain. This indicates that the subdomain is

assigned as a porous media and the calculation for the flow passing through the

subdomain will be based on the Darcy equation. To assign properties on the

subdomain, the 'Subdomain Settings' menu (Refer Figure B-3 in Appendices) was

opened from 'Physics' > 'Subdomain Settings'. For subdomain 1, in the 'Physics'

tab, the following values were put inside the text box: 'rho' for 'Density', 'perm' for

'Permeability' and 'eta' for 'Dynamic Viscosity'. For 'Source Term' the text box was

left as it was. Using the names of the variable specified in the text boxes, the

programme would find values corresponding to each name from the values specified

in 'Constant'.

IX
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Figure 4 Geometry ofthe model for FEMLAB simulation

The next step involves the setting of the boundary condition at the boundary of the

subdomain. In Darcy models, the boundary condition may be the flux, pressure

conditionand insulation/symmetry. Flux condition is used to specify the rate of flow

enteringof exitingthe boundary. The pressure condition is used to specifypressure at

the boundaryof the subdomain, while insulation/symmetry indicates that there will be

no flow passing through the respective boundary, where flux and pressure is not

specified. The model consists of 6 boundaries and the condition for each of them is

summarized in Table 4. The term vO in the first boundary condition corresponds to

the inlet superficial velocity. Its value has been specified in the 'Constant' menu. To

open the 'Boundary Settings' menu (Refer Figure B-4 in Appendices), 'Boundary

Settings' was selected from 'Physics' drop-down menu. Then, the 'Boundary

Condition' was set to 'Flux', 'Pressure Condition', or 'Insulation/Symmetry',

according to Table 4 below.
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Table 4 Boundary Conditions forFEMLAB Model

Boundary Location Boundary Condition

1 Inlet of the filter cloth Flux at vO

Sides of the filter cloth Insulation/symmetry

Outlet of the filter cloth Pressure at 0 Pa

Then, the model was divided into small sections called mesh. The mesh used in this
model is the default type, which is tetrahedron ofnormal size. The actual dimension

of the mesh will be determined by the software based on the geometry drawn. The

mesh should besmall enough to fit the geometry, but not too small as it can result in

longer time taken to solve the model. The mesh size should also fit the capability of
the computer used to solve the model. If the mesh size is too small, the program may
run out of memory. The mesh was started using 'Mesh' > 'Initialize Mesh' was

selected. This action divided the model into meshes using default setting. If other

mesh setting was needed, it can be set from 'Mesh' > 'Mesh Parameters'. The menu

for thisfeature is shownin FigureB-5 in Appendices.

3.2.2 Model Solving to Obtain Pressure Drop

The next step is to solve the model. The FEMLAB solver was used to find the
solution of the model, yielding the properties that is needed. 'Solve Problem' was

selected in 'Solve' drop-down menu. The solver used in this model was stationary

nonlinear solver. The type and properties of solver may be changed through 'Solver

Manager' (Refer Figure B-6 in Appendices) and 'Solver Parameters' (Refer Figure B-
7 in Appendices), also in the 'Solve' drop-down menu. By default, the solved model
displayed the solution in terms ofvelocity field. The parameter to be displayed in the
solved model was changed to pressure, as this will show the pressure drop across the

filter cloth. This was done by selecting 'Plot Parameters' (Refer to Figure B-8 and

Figure B-9 in Appendices) in 'Postprocessing' drop-down menu. The type of display

9.0
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chosen was slice, which shows the parameter value using colour scale. The red colour

will indicate the highest value, while blue colour will indicate the lowest value.

As the numerical number is not shown directly on the solution plot, it is difficult to

obtain the exact pressure drop across the filter cloth. To overcome this problem,
another feature of FEMLAB is used, which is the cross-section plot. The 'Cross

section Plot Parameters' (Refer to Figure B-10 in Appendices) was selected from

'Postprocessing' drop-down menu. From 'Line/Extrusion' tab, 'Line Plot' was
chosen as the 'Plot Type' and for 'y-axis data', 'Pressure' was chosen as the

'Predefined Quantities'. The coordinates for the line along which the pressure value
would be measured was specified in the 'Cross-section Line Data' as (0, 0.04241,

0.1) to (0.002, 0.4241, 0.1). Atine was drawn perpendicular to the filtering surface
and passing through the center ofthe filter cloth geometry. The pressure along this
line was then plotted on a graph ofpressure versus distance in the x-coordinate. The
sample ofthis kind of plot is shown in Figure B-ll in the Appendices. The same
approach can be used to obtain the outlet velocity ofthe filter cloth.

3.2.3 Determination ofPorosity

In this model, mere was no filter cake taken into consideration. As a result, the

porosity that can be determined from this approach is the porosity ofthe filter cake
itself. This can still be a beneficial information, as the porosity obtained can be

compared with the porosity value obtained from the equipment supplier.

The variant ofErgun equation 15 is used to calculate the porosity. As the value of
porosity cannot be determined directiy from the equation, interpolation method is
used. Values ofporosity, which is known as inthe range of0 to 1 is used to find the
corresponding value of dimensionless pressure drop /0. Then, the dimensionless
pressure drop whose porosity is to be found was calculated using equation 16. The
dimensionless pressure is used toget the porosity from interpolation.

To simulate the changes caused by flowrate and total filtering area change, the Qand

Ainthe constant dialog box is varied among these values: 130, 90, 50 and 10 m/hr

71



for flowrate and 0.4241, 0.8482, 1.2723 and 1.6964 m2 for total filtering area. The

results were then plotted into graphs to be compared with different model approach.

3.2.4 Determination ofEfficiency

Thepressure dropobtained fromthe FEMLAB model is assumed as the totalpressure

drop of the filter cloth and filter cake. The pressure drop from the filter cloth is

calculated as the slope of Ap versus u graph, multiplied by the u value. Fromthis

data, die Ap^ can be calculated.

The efficiency of the filtration process is modeled using the combination of equation

8 and 10 to yield the relationship between the pressure drop across the cake Apcake

with the mass collected per unit area W

W= Ap^CpdP2 (28)

18uw

This W will be used to calculate the efficiency using

T1=WAVin (29)

where W-m is the mass at the inlet of the filter.

3.3 Prediction of Filtration Parameter using Model by Al-Otoom

The process of prediction of filtration parameter using Al-Otoom's approach is done

using Microsoft Excel. Thereason whythe respective software is usedis because it is

easier to use. Although there are a lot of programming software available in the

university, such as MATLAB and C++ programming, they are more difficult to

handle. Even though Ihey do have an advantage of the ability to produce better user

interface, time constraint will be interrupting the process of studying the features of

these software. Furthermore, as they were a lot of particles and parameters to be

considered in this approach, it would be preferable of each of the calculating step can

be easily monitored so that mistakes can be easily detected and corrected. This

advantage is found on Microsoft Excel.
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3.3.1 Determination ofFiltration Efficiency

In his paper, Al-Otoom uses 4000 particles deposited on 0.05 cm x 0.05 cm of filter

cloth. In this study, the number used will be at most 1000 particles deposited on

68.6468 urn x 68.6468 urn This is to simulate 0.1 kg of dust sample on 1 to 4 filter

bags, each having the filtering area of 0.4241 m2 The number of particles will be
varied to 500, 333 and 250 to simulate the increase in the filtering area. Theparticles

used inthis simulation is a hypothetical particle of2000kg/m3 density as stated in de

Nevers (2000) for unspecified particle and diameter range 1-40 um, which is inside

the range of milled flour particle diameters (de Nevers, 2000, p. 210). The pore

diameter used is 15 pm The distance between the successive pores is calculated using

the equations specified in section 2.3.1.

After that, the particle diameter and falling location is specified using equations

specified in section 2.3.2 and 2.3.3, respectively. In Microsoft Excel, the RAND()

function is used to generate random numbers between 0.025 and 1 to obtain the

particle diameter within the range specified. For the falling locations, the same

function was used, but the range of the randomnumberwouldbe within 0 to 1.

To find the distance between the falling particle and the particles that are already

deposited on the filter cloth the equation shown below is used. (xx, y0 is the

coordinate of the falling particle, while (x2, yi) is the coordinate for other particles

deposited on the cloth. The MIN0 function is thenused to find the minimum among

the distances. If this distance is smaller than or equal to the summationof the radii of

the falling particle and the particle closest to it, the particle will be trapped on the

cloth and a constant TRUE is assigned on the particle. If not, the constant FALSE

will be assigned.

Distance = ((xi - x2)2 + (yi- y2?)m (30)

The same equations were used to find whether the particle escapes the cloth through

thepores onthe cloth. Butin this case, the coordinates used are the falling particle's

and pores' coordinates. If the minimum distance is bigger than orequal to the particle

and pore radius, the particle will be trapped onthe filter cloth and the constant TRUE

is assigned on theparticle. If not, a FALSE will be assigned to it.
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After determining whether the particles pass through the filter cake and cloth

separately, the TRUE and FALSE constant for each condition of each particle will be

combined to determine whether the particle pass through the whole filtration system

or not. The conditions and decision on whether the particle passes through or trapped

on the filter system is shown in Table 5.

Table 5 Determination of the Particle Entrapment on the Filter System

Constant at Filter Cake Region Constant at Filter Cloth Region Particle

Trapped

TRUE TRUE TRUE

TRUE FALSE TRUE

FALSE TRUE TRUE

FALSE FALSE FALSE

The particle with the constant TRUE assigned on the last column in the table above

are the particles that are trapped on the filter cloth and contributes to the formation of

filter cake. From the number of particles trapped and the total number of particles, the

efficiency can be calculated as the number of particles trapped over the total number

ofparticles. The efficiency of the filtration is expressed in terms of percentage.

3.3.2 Determination ofCake Porosity

To get the porosity of the cake, the volume of the particles trapped and the cake

volume is needed. The volume of particles trapped can be directly calculated using

the equation ofvolume ofsphere

V = (4/3)7irp (31)

where V is the volume of the sphere and rp is its radius. To calculate the volume of

the cake, the height of the cake is needed. Al-Otoom states in his paper that a

geometrical analysis is used for this purpose, but no further explanation on how the

analysis was done was present in his literature. Due to this reason, an additional

assumption is made to facilitate the height calculating process, which is that all

particles located at the same 17.16171 um x 17.16171 pm squares on the filter cloth
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will be stackedon top of each other. This means that the height at each 17.16171 pm

x 17.16171 um squares is equal to the summation of the diameters of the particles

inside the region. After the height of each square is obtained, the highest value is

taken as the height of the cake. From this height, the volume of the cake and its

porosity is calculated. The simulation is repeated for smaller particle number, which

denotes the increase in total filtration area.

3.3.3 Determination ofPressure Drop

The pressure drop is determined using the variant of Ergun equation, or equation15.

The pressure drop is calculated using varied superficial velocity, which is the same as

the velocity used in the FEMLAB model.

Finally, all the filtration parameters obtained is plotted as graphs to show the trends

and to facilitate the comparison between the models. Initially, an experiment of atta

flour filtration was planned to be done, but it was cancelled due to equipment

malfunctioning. An experimental data would be useful to verify both models.
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CHAPTER 4

RESULTS AND DISCUSSION

This discussion will be in terms of comparison between the two models, the first one

is the FEMLAB model using Darcy's Law, and the other one is the model developed

by Al-Otoom based on the size and distribution of particles to determine the pressure

drop, porosity and particle collection efficiency.

4.1 FEMLAB Solution

Sice: Pressure Max 210-39

)j04
- -140

4, -120

1100

1D2
|8Q

L* 140

x1e-3

Rtn: 23377

Figure 5 Sample of Solution to Find Pressure Drop using Darcy's Law in
FEMLAB
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The plot of pressure distribution of the filter cloth was obtained using FEMLAB and

was shown in Figure 5. The dark red surface is die inlet surface of the filter cloth,

while the back side, which is in dark blue, is the outlet surface of the filter cloth

Using the colour scale in the figure, it can be interpreted that the pressure at the inlet

is higher than the outlet. This indicates that there is a pressure drop across the porous

media, which is expected.

4.2 Pressure Drop

Accordingto Nassehi et al, "the maximum contribution to the pressure drop value is

by virtue of the flow through the porous medium". An expected rise in the pressure

drop is noted across the porous media along the flow direction. For the FEMLAB

model, this is a result of low permeability. In this case, the permeability is as low as

2.9115306 x 10"12 m2. The air flow will behindered due to this low penneabihty. The

resistance to the flow through the porous media is also due to the friction between the

flow and the structure of the porous media As a result, pressure will build up at Ihe

inlet of the filter cloth. Also, as the outlet of the filter cloth has a zero pressure

condition, a differential pressure will exist across the filter media

In case of the model by Al-Otoom, die facts above are also true. But as this model

considers only the pressure drop resulting from die filter cake, the factors contributing

to tiie increase of pressure drop across the filter media are the properties of the cake,

such as Ihickness and porosity.

The result of pressure drop for Al-Otoom's model is shown in Figure 6 while the

pressure drop from FEMLAB model is in Figure 7. It is found that the pressure drop

of Al-Otoom's model is significantly less than the pressure drop simulated using

FEMLAB model. This is due to small amount of mass sample simulated; so the cake

thickness for Al-Otoom's model is very small compared to tiie thickness of the filter

cloth present in the FEMLAB model. As the Ergun's equation used considers the

thickness of the porous media, the pressure drop will be less as the thickness of the

porous media decrease.
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Figure 6 Pressure Drop Simulated using Al-Otoom's Model
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Figure 7 Pressure Drop Simulated using FEMLAB Model
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As the gas flowrate increases, tiie pressure drop will also increase. This is due to more

gas molecules become in contact with the filter at its inlet side. As there is a

resistance to the flow introduced by the porous media, larger amount of molecules

will exert more pressure on the filter cloth, resulting in higher pressure drop across it.

The trend of change of pressure drop due to the increase offlowrate is found to be the

same in both of the models used.

For fixed flowrate, change ofpressure drop is also found as the area of the filter cloth

increase. The pressure drop of smaller filter area would be smaller than that of larger

filter area For FEMLAB model, this change is due to less flowrate per unit area, or

superficial velocity u. Larger filtering area provides more space for the air molecules.

This will result in less force exerted by air molecules per unit area and lower pressure

drop.

43 Filter Media Porosity

The pressure obtained from FEMLAB model is used to calculate the porosity of the

filter cloth. As no filter cake is considered for this calculation, the porosity of filter

cloth is obtained at the range from 0.6023 to 0.6026, which complies with the value

specified by the supplier. This shows that the pressure drop simulated using

FEMLAB and Ergun equation can be used to determine the porosity of a porous

media if the value is unknown.

The model by Al-Otoom yields the filter cake porosity value as shown in Figure 8. It

is found that the porosity of the cake is within the range of 0.84 to 0.875 and they

increases as filter area increases. The decrease in the filter area, which is the total

filtering area, will result in larger amount of particles per unit area More particle per

unit area means that there will be some particle that occupies tiie spaces between the

particles that forms the cake. This results in less volume of voids per volume of cake,

which means less porosity. It can be said that the result complies with tiie theory.

However, the values obtained for the porosity is quite high, which is more than 0.8.

This condition may be due to the additional assumption to the model, which is that all

particles located at the same 17.16171 pm x 17.16171 pm squares on the filter cloth

?.o



will be stacked on top of each other. This assumption may not be suitable to be used

as assumption for the arrangement of particles in the cake as it may increase the

number of voids present in the cake. However, as the geometrical analysis mentioned

by Al-Otoom is not explained further and there were lack of suitable software to do

this analysis, the fact that the porosity follows the actual trend of porosity as filter

area increases is satisfying enough for the time being.
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0.845
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0.2 0.4 0.6 0.8 1 12

filter area (m2)

1.4 1.6 1.8

Figure 8 Filter Cake Porosity Simulated by Al-Otoom's Model

4.4 Filtration Efficiency

As the FEMLAB model does not include the mass or amount of particle entering the

filter system from the start, the amount ofpressure drop contributed by the filter cake

will be very small. This value is calculated by subtracting the pressure drop

contributed by the filter cloth from the simulated pressure drop. As shown in

equation 7, the pressure drop by the filter cloth is defined as Apo = Ki«, it is

calculated using the slope of Ap versus u graph as Ki (Figure 9) and superficial

velocity u. The value ofKi is found to be 10301 Pas/m.
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Figure 9 Graph to Determine the Value ofKi.

As the filter cake is unable to be taken into account, the pressure drop obtained from

the filter cloth made up almost all of the total pressure. The residual pressure drop,

which is the pressure drop contributed by the cake is too small and leads to low and

inconsistent efficiency. However, this method may yield better result if experimental

data on die filter cake is used in the prediction of the pressure drop. The new pressure

drop calculated may consist of the pressure drop from the filter as well as the pressure

drop from die cake

For the model by Al-Otoom, the efficiency is as shown in Figure 10. The efficiency is

found to be high, but decreasing with filtering area. However, the range is very small,

which is 99.6% to 99.9%. The decrease is due to the reason that larger filtering area

means less particle per unit area, thus there will be less cake formed. The cake formed

on die filter cloth will also act as filter and less cake formed may result in less

efficiency.
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CHAPTER 5

CONCLUSION AND RECOMMENDATION

5.1 Conclusion

From the project, it can be concluded that the model by Al-Otoom agrees with the

filtration theory in terms of pressure drop, porosity and efficiency. The porosity is

found to be high possibly due to the additional assumption used in determining the

height of the cake. The FEMLAB model developed using Darcy's Law, Ergun

equation and approach stated by Novick and Klassen agrees with the filtration theory

in terms of pressure drop and porosity. The porosity calculated by this approach is the

filter cloth porosity. The efficiency calculated by this model is low and inconsistent

possibly due to no incorporation of particle mass or amount in the flow model by

FEMLAB

5.2 Recommendation

It is recommended that improvement is done to the FEMLAB model in terms of the

consideration of the inlet mass or amount of particle in the pressure drop modelling

using FEMLAB. The filter cake simulated will help the calculation of pressure drop

contributed separately by filter cloth and filter cake, which will help in the calculation

of porosity and efficiency. Also, to further verify the model by Al-Otoom, it is

suggested that suitable software is used for the geometrical analysis instead of using

assumptions.
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APPENDIX A

PORE AND PARTICLE COORDINATE ASSIGNMENT

pore coordinates

pore no. X Y

1 0.000000 0.000000

2 0.000000 17.161711

3 0.000000 34.323421

4 0.000000 51.485132

5 0.000000 68.646842

6 17.161711 0.000000

7 17.161711 17.161711

8 17.161711 34.323421

9 17.161711 51485132

10 17.161711 68.646842

11 34.323421 0.000000

12 34.323421 17.161711

13 34.323421 34.323421

14 34.323421 51.485132

15 34.323421 68.646842

16 51.485132 0.000000

17 51.485132 17.161711

18 51.485132 34.323421

19 51.485132 51.485132

20 51.485132 68.646842

21 68.646842 0.000000

22 68.646842 17.161711

23 68.646842 34.323421

24 68.646842 51.485132

25 68.646842 68.646842
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particle
no Radii X y

1 12.366976 5.993476 31992565

2 15.827181 43.978965 14.722303

3 2.294085 48.050898 64.550841

4 2.326461 40.586204 0.794943

5 16.926149 61.086532 60.313603

6 15.396783 34.806966 30.920557

7 14634179 8.131206 19.503218

8 11.077997 30.076468 45.518097

9 17.514760 4.076640 3.512038

10 12.833509 66.527871 63.025922

11 7.646799 18.381486 26.664044

12 4.054427 30.238277 7.515275

13 12.049835 31.553567 18.683028

14 16.428768 12.143021 36.571068

15 14.483383 37.674790 55.102853

16 12.821287 6.929252 27.040687

17 12.878699 65.752293 59.512448

18 13.770213 23.001666 16.940872

19 17.810880 41820849 7.290611

20 6.960309 51860120 63.012328

21 18.588518 8.084014 54.147943

22 17.763717 3.410369 34.596565

23 19.564519 46.488041 64.965263

24 17.219778 26.872054 5.184581

25 16.852215 14.071730 17.941872

26 6.942341 46.922494 41771405

27 5.569323 62.093709 28.213616

28 11442414 32.961760 26.597591

29 16.236108 59.373255 65.383836

30 10.506325 5.771155 42.083787

31 5.281782 25.532856 11340266

32 17.027712 29.141606 44.531704

33 2.196915 46.469692 16.072611

34 15.375428 65.616523 34.515800

35 11.548646 24.916857 42.772634

36 9.131853 36.725478 11836612

37 4.779301 48.259853 25.652300

38 7.794894 56.040677 7.787774

39 15.070224 45.109419 63.634470

40 6.638372 37.188861 45.249989

41 14.053510 54.851283 48.561283

42 14.177368 45.221135 29.437522

43 13.119087 53.153580 34.433283

44 4.982232 61164700 44.925484

45 9.784427 34.331667 35.210728

46 17.312103 59.478241 48.783934

47 14.779319 7.364840 32.226476

48 10.647150 0.845039 66.544716

49 15.020876 16.235918 66.044945

50 6.189634 9.051969 24.798074

51 18.840604 0.663476 33.510157
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52 6.944529 5f) 478938 ^r ?7fiR?H
5Ci 2.118453 8.97157EJ 67.700483
5< 13.262804 40.40049C 58.957404
5£ 19.931386J 32.917612 59.767331
56 8.290837 40.885225 22.295086
57 1306502 27.193015 34.152964
58 8.61456E 38.738773 42.751628
59 15.733479 13.352989 40.753420
60 4.245862 0.601005 12.731101
61 1498689 60.635114 36.081176
62 13.510933 13.362208 51999332
63 12.243396 17.809898 25.181083
64 11734968 32.335159 40.171477
65 16.450577 54.948646 48.728521
66 9.986135 29.759704 43.675766
67 10.549370 6.760691 28.318657
68 7.358663 10.798455 19.558871
69 10.382317 57.322986 5.438580
70 16.930940 21393153 42.566969
71 17.501457 4.110705 34.881968
72 2.512665 25.036411 38.208331
73 19.882638 20.676906 68.411603
74 17.394538 42.987909 10.217589
75 8.356102 53.719526 44.832151
76 11401001 67.895937 4714214
77 12.443721 68.624319 15.299679
78 13.269812 17.452055 20.759792
79 4.817447 41351967 28.952395
80 12.566154 13.353255 61078358
81 5.710869 28.727968 58.453464
82 3.512177 1175735 54.629775
83 5.886660 13.174419 48.205758
84 17.706829 15.118805 25.229626
85 4.184511 61992614 40.101584
86 9.085436 19.974699 41836569
87 8.321501 51389579 36.545466
88 5.511883 40.167156 23.956294
89 10.642235 32.141721 45.819112
90 9.254864 8.871854 23.670657
91 6.784710 11896069 6.396602
92 4.963717 31516750 59.936724
93 18.455284 14.722254 66.722283
94 13.546414 58.679407 34.192437
95 9.914360 64.751031 12.492780
96 5.861500 59.299604 52.737849
97 6.236355 68.329872 ;38.468772
98 10.453682 36.254592 C30.002669
99 19.819910 12.884419 i17.609117

100 | 1216342 34.941853 *• K).718965
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APPENDIX B

FEMLAB FEATURES MENU
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Figure B-1: Model Navigator
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Appfcafon mates for fundamental physics
and for defining your own equations.
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Figure B-3: Subdomain Settings
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Figure B-4: Boundary Settings
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' Maximum element size:
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: Mesh curvatire factor 0.4

! Mesh curvature cut off 0.01

' Mesh geometry to level: ISubdomain :v j
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Figure B-5: Mesh Parameters
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Figure B-6: Solver Manager
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• Adapfion
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Figure B-7: Solver Parameter
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Figure B-8: Postprocessing (General tab)
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Figure B-9: Post processing (Slice tab)
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Figure B-10: Cross Section Plot Parameters

47



Figure B-11: Cross Section Plot Sample
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